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1 Introduction 
The purpose of this Troubleshooting Guide is to provide the reader with an overview to 

troubleshooting Agilent G3335AA MassHunter Workstation Software.   This includes: 

 

 Quantitative  Analysis 

 Qualitative Analysis 

 MassHunter Reporting 

 Automation (Worklists and Scripts) 

 

Please refer to the various sections for troubleshooting specific problems.  Troubleshooting 

Acquisition problems is covered in the specific Troubleshooting Guide for that instrument.   If you 

cannot find an answer to the specific problem, it is recommended that you contact the Service 

Channel Assist team. 
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2 Error Messages 
 

2.1 MassHunter Log Files 

 

Many MassHunter program generate log files during their operation.  These log files can be useful 

in debugging the program if an error occurs. 

 

2.1.1 Quantitative Analysis Log 

 

Under D:\MassHunter\Log\quant\ there are a set of GZIP files named  

yyyy-mm-dd.hh.mm.ss.quanttrace.gz (where yyyy—mm—dd.hh.mm.ss is a date and time stamp. 

 

 
 

Each time the Quantitative Analysis software exits (either normally or with an error) it writes out 

this file and timestamps it.  It can be opened with WinZip or WinRAR to read the text file inside. 

Quant logs every action, so it can be used to track down an error.   
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If sending it to support personnel, please only send the file associated with the crash rather than 

the entire folder. 

 

2.1.2 MassHunter Reporting Trace File 

 

It is possible to turn on a trace file for the MassHunter Reporting system.  The add-ins for reporting 

are located in the folder C:\Program Files\Microsoft Office\Office12\Library.  Each MassHunter 

add-in has a configuration file named MassHunter Reporting <appname>.config.  A trace file can 

be created by opening this file in Notepad and changing the Trace enabled attribute from ―False‖ to 

―True‖: 

 

 
 

The location of the trace file can be placed in the TraceFile name attribute. 

 

2.2.1 Quantitative Analysis Error Reporting System 

 

Occasionally when Quantitative Analysis experiences a major error, it will put up a dialog like this: 
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This dialog allows the user to send log file and system information back to the Quantitative 

Analysis R&D group, where it can be used to fix the error.  For example, the existence of the 

following defect: 

 

PVCS 12032: Entering an invalid serial dilution pattern can crash the application 

 

was reported by a customer in the EMEA region using this dialog. 

 

******************************* 

This mail was sent to you from Agilent Developer Network Support 

Time:  Fri Oct 12 02:41:00 2007 

  

Subject: Error Report: Quant Analysis 

  

Product ...................................... Quant Analysis 

Problem  *** Contact Information *** 

Name:   <text deleted> 

E-mail: <text deleted> 

Phone:   

  

*** Exception Information *** 
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Exception Location - App: QuantAnalysis.exe, FileVersion: 1.2.80.10 

.....................Module: System.Number 

  

Exception 1: System.FormatException 

Message:  Input string was not in a correct format. 

Source:   mscorlib 

Site:     Void StringToNumber(System.String, System.Globalization.NumberStyles, NumberBuffer 

ByRef, System.Globalization.NumberFormatInfo, Boolean) 

   *** Stack Trace *** 

   at System.Number.StringToNumber(String str, NumberStyles options, NumberBuffer& number, 

NumberFormatInfo info, Boolean parseDecimal) 

   at System.Number.ParseDouble(String value, NumberStyles options, NumberFormatInfo numfmt) 

   at System.Double.Parse(String s, NumberStyles style, NumberFormatInfo info) 

   at Agilent.MassSpectrometry.DataAnalysis.Quantitative.SerialDilution..ctor(String dilutionPattern) 

   at 

Agilent.MassSpectrometry.DataAnalysis.Quantitative.CalibrationSetup.CreateCalibrationLevelsImpl(

TargetCompoundRow compoundRow, Int16 numberOfLevels, String levelNamePrefix) 

   at 

Agilent.MassSpectrometry.DataAnalysis.Quantitative.CalibrationSetup.CreateCalibrationLevels(Int1

6 compoundId, Int16 numberOfLevels, String levelNamePrefix) 

   at Agilent.MassSpectrometry.DataAnalysis.Quantitative.CmdCreateSerialDilutionLevels.Do() 

   at Agilent.MassSpectrometry.CommandModel.CommandHistory.Invoke(ICommand cmd) 

   at 

Agilent.MassSpectrometry.DataAnalysis.Quantitative.AppCommandContext.ProcessCommandQueu

e(Object sender, EventArgs ea) 

******************************* 

 

(Note: Text has been deleted in the extract above to protect the privacy of the user). 
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3 Troubleshooting Software Problems 
 

3.1 General  
 

3.1.1 Routine Disk Maintenance 

 

It is important for customers to perform routine disk maintenance on their MassHunter 

Workstation PCs.  In some cases, communication errors with the MassHunter system have been 

resolved by performing the steps below. 

 

To help optimize the performance of MassHunter Workstation, it is important that users schedule 

routine maintenance (e.g. deleting unnecessary files). The following instructions should be used as 

a part of a routine maintenance schedule. 

 

You will need administrator capability to perform these tasks. 

 

Run the Disk Cleanup utility 

 

1. Select Start… Programs… Accessories… System tools… Disk Cleanup 

 

2. Select the Drive (C:\, D:\, etc) you want to cleanup 

 

3.   Select Temporary files, Temporary Internet files, and Recycle bin. 

 

You may select other type of files to delete, depending on your understanding of these file types, 

and the way the PC is used.  It is possible to delete vital files with the Disk Cleanup utility, so do 

not delete files types that you do not understand.  Do not "Compress old files" on a MassHunter 

Workstation PC.  You may wish to highlight Recycle bin and click View to see the contents of the 

Recycle bin before you allow Disk Cleanup to delete these files.  

 

4.   Once you are satisfied with the selections, click OK. 

5.   Repeat these steps for other drives on your system. 

Be sure you delete the contents of the TEMP folder, but not the folder itself! 

Check the Disk Drive for Errors 
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1.   Double-click My Computer on the Desktop, and highlight the C: drive. 

2.   On the File menu, click Properties. 

3.   Click the Tools tab. 

4.   Under Error-checking, click Check Now… 

5.   The Check Disk options windows will appear, select the Automatically fix file system errors and 

the Scan for and attempt recovery of bad sectors check box. Click on the Start button. 

Select Yes to the prompt titled, ―Checking Disk System (C:)‖ –―The disk check could not be 

performed because the disk check utility needs exclusive access to some Windows files on the 

disk. These files can be accessed only by restarting Windows. Do you want to schedule this disk 

check to occur the next time you restart the computer?‖ This is a normal prompt. 

6. Reboot the computer, allow the disk check to finish, then login to XP as usual. 

Repeat steps 1-6 for the other drive letters on your local hard drive. 

Analyze and Defragment the Drives 

1.   Select Start… Programs… Accessories… System tools… Disk defragmenter 

2.   Select the Drive (C:\. or D:\ , etc.) you want to analyze. 

3.   Click Analyze. 

  

 

FIGURE 1: Color Legend for Drive Map 
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FIGURE 2: Typical Drive with Moderate Fragmentation and Message ―Diskeeper has completed 

analysis of this volume and found 121 fragmented files and/or directories and 833 excess 

fragments. 

The average number of fragments per file is 1.02. 

This volume is moderately fragmented, with 52% of the total volume space available for 

defragmentation.  This amount of free space is sufficient for effective defragmentation at this time, 

but as the volume fills up, lack of free space will cause a performance problem.  You might 

consider which files you could delete or move to another volume to maintain enough free space to 

keep the fragmentation level low.  If you haven't run Diskeeper on this volume yet, it is time to do 

so.  If you have run Diskeeper on this volume, you should schedule Diskeeper to run more often 

than it has been running to reduce the current fragmentation and maintain a lower level of 

fragmentation.‖    

4.   If the result of the analysis shows that the drive needs defragmenting, click Defragment. 

Otherwise, defragmentation is not necessary at this time, and you can click Close. 

5.   Repeat for the other drives on your system. 

Please note the following suggestions for the use of these utilities: 

• Choose a time when the system is quiet (not acquiring or processing data, and not printing) 

to perform disk maintenance. It is possible to do other tasks while Disk Defragmenter is running, 

but it's not recommended. 
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• Defragmentation can require a long time, depending on the size and condition of the drive 

being processed. Choose a time when you can allow the process to complete before acquiring, 

printing or processing data. Defragmenting more frequently can reduce the time required to 

complete the task. 

• Microsoft® recommends that disk drives maintain 30% free space, to insure proper 

operation of the Disk Defragmenter utility. The utility will fail on drives that are almost full 
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3.2  Quantitative Analysis 

 

3.2.1 “NO DATA POINTS” seen in Quantitative Analysis for data files that are valid 

in Qualitative Analysis 

 

There are three known causes of this problem: 

 

--The data is negative mode and Quantitative Analysis‘ method is set up for positive mode 

 

The default ion polarity for Quantitative Analysis is positive.  Since Ion Polarity is a column in 

Quantitative Analysis that is not displayed by default, it may be necessary to add the column in the 

Method Edit area and switch it to Negative for the compounds to appear. 
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--The Acquisition Time Segment is too short 

 

Another cause is that the Acquisition Time Segment is too short to acquire enough data points for 

the integrator to integrate the main peak.  This will occur while creating a new Quantitative 

Analysis method using the MethodNewNew Method from Acquired MRM Data menu item.  

After creating the method, there may be one or more Time Segments (TS) in the method that have 

a Retention Time (RT) of 0.000: 
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The reason for this is that the MS/MS Parameterless Integrator needs at least 64 data points to 

integrate a peak.  If a particular transition is acquired in too short a Time Segment, it will not have 

enough data points.  Since no peak is found, no Retention Time is recorded for that compound. 

 

The workaround is to edit the QuantAnalysis.exe.config file.  Open the file and search for the line 

 

<add key="IntegratorChoice" value="AutoMagic"/> 

 

Change the "AutoMagic" to "RTE" i.e. 

 

<add key="IntegratorChoice" value="RTE"/> 

 

The General (RTE) Integrator will now be the default integrator for creating the quantitative method 

using the Method-->New-->New Method from Acquired MRM Data menu item; it does not require 

64 data points to integrate a peak.  However, a superior solution from a data quality standpoint is 

to examine and adjust the Acquisition conditions.  Often, data files that have exhibited this problem 

have Time Segments that are too short with too many MRM transitions.  Due to the short Time 

Segments, some compound peaks are on the boundary and cut off, such that no integrator could 

successful integrate them.  The user should also investigate the use of Dynamic MRM in order to 

more efficiently acquire data. 

 

--The data was acquired as as triggered MRM data on an LC/QQQ and the minimum version of 

Quantitative Analysis is not used 

 

The minimum version of Quant to process LC/QQQ tMRM data is Quant rev. B.04.00 Service Pack 2 

(SP2 Build 225.19). Earlier versions will show a chromatogram with ―NO DATA POINTS‖  

 

 

3.2.2 Peaks are not integrated despite being in the extracted time window 

 

A user may have a peak where the retention time has shifted.  However, the peak is still firmly 

within the extracted time windows.  The user will notice that the program will not allow the peak 

to be integrated, even when they try to use manual integration on it.  Often, the cause is that the 

Non Reference Window in the Globals Setup area of the Method Tasks area is too small for the 

user‘s analysis.   

 

For example, if a user‘s expected retention time were 2.8 minutes and their extraction windows 

was the default 1 minute on each side, the extracted window would be 1.8 to 3.8 minutes.  

However, if their actual peak was at 2.2 minutes and their Non Reference Window were set to 
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40%, the Quantitative Analysis would only look for their peak from 2.35 to 3.35 minutes.  Expanding 

the Non Reference Window to 60% (1.95 to 3.65 minutes) would cause the peak to be detected. 

 

 
 

Please note that the Non Reference Window is the total time range around the Expected RT.  That 

is, a Non Reference Window of 60% looks 30% to the left of the Expected RT and 30% to the right. 

 

Two better solutions might be to: 

 

1) Change the Expected RT for the compound in the quantitative method so that it more 

closely matches the actual RT 

2) Set the Non Reference Window Type to Minutes in Globals Setup and match the extraction 

window.  E.g. if the extraction  window is 1 minute on each side, set the Non Reference 

Window to 2 minutes. 

 

3.2.3 Method validation error when exiting Quantitative Analysis 

 

In general, after editing a quantitative method in the Method Edit area, it is prudent to press the 

Validate button under Save / Exit.  This will either report ―Method validated.  No errors or warnings 

found‖ or report specific errors in the Method Error List at the bottom of the screen.  Double-

clicking on the error in the Method Error List will take the user to the specific location of the error 

in the quantitative method fields above. 

 

Method validation is also applied automatically when exiting Quantitative Analysis.  The user is not 

allowed to apply the edited method to the batch until all validation errors are cleared.   

The user can select a Non Reference 

Window Type of Percent or Minutes 
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One method validation error that would occur on versions of Quantitative  Analysis prior to B.01.04 

―Method validation error:  exception = System.Data.StrongTypingException: The value for column 

‗CalibrationSTDPathName‘ in table ‗Calibration‘ is DBNull.‖   

 

 
 

This is caused by the fact that the Cal. Path column in the Concentration Setup area is null, that is, 

it does not have any values in its fields.  The Cal Path column is one of the columns that is not 

shown by default—it must be added.  The solution to this error is to place values (i.e. the path of 

the calibration samples) into the fields.   
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It is even possible to put the path of a sample in every field in order to clear the error. 

 

3.2.4 Data files display the wrong acquisition time in the Batch Table 

 

For example: 
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(Note: Text has been deleted in the graphic above to protect the privacy of the user). 

 

What typically causes this ―default‖ time of 3/20/2005 8:30 PM to be displayed in the Batch 

Table‘s Acq Date-Time field is if the user has added the data file to the batch before the acquisition 

run is completely finished (e.g. during the LC Post-Run time).  Please note that the Completed 

column of the Batch Table is not checked for the last two samples in the batch.  The user can 

remove the affected samples from the batch and add them again. This should solve the time stamp 

problem and also the ―Completed‖ flag should then be set. 

 

3.2.5 Red X shows up in Compound Information Window 

 

While trying to review data in the Batch Table, the user may see a red X in the Compound 

Information Window as well as a Quantitative Analysis error: 

 

Deleted 

Text 

Deleted Text 
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(Note: Text has been deleted in the graphic above to protect the privacy of the user). 

 

This is more likely to happen on pre-B.01.04 versions of the Quantitative Analysis program.  The 

typical cause is when qualifier ratios for calibrators are updated.  If a qualifier for a calibration 

sample is not integrated, the program will place ―NaN‖ (in computer science terms, ―Not a 

Number‖, or null) in the "Rel.Resp." cell of the compound or internal standard's qualifier rather 

Deleted Text 
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than a numeric percentage.  During review, the red X will appear.  If the Nan is replaced with an 

actual percentage and the edited quantitative method applied to the batch, the red X will go away. 

 

The ways to solve this problem are: 

 

1) Check the samples and quantitative method to find out why the qualifier did not integrate; 

fix this problem 

2) Upgrade to a version B.01.04 or greater 

 

3.2.6 “Failed to load batch file” when opening batch 

 

Some users have tried to load a batch file into Quantitative Analysis and seen the following error 

message: 

 

 
 

Checking the file system shows that their batch file has 0 bytes in it.  What has occurred is that 

the user has created a new batch, worked on it for a while, and then had Quantitative Analysis 

crash.  Since the new batch had never been saved to disk, nothing was ever written to the batch 

file from the PC‘s memory. 

 

To avoid this problem: 

 

1)   Install any Service Packs for Quantitative Analysis for that version of Quantitative Analysis to 

avoid crashes. 

2)   Periodically save your work to hard disk using the FileSave Batch menu item in Quantitative 
Analysis. 

 

3.2.7 Error while printing from Quantitative Analysis 

 

Users have observed that in some cases when printing a report from MassHunter Quantitative 

Analysis software to a printer or to a pdf file, Excel comes up with an error: 
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Task error 

―Excel report module did not respond. Excel processes may have been terminated.‖ 

The workaround for the moment is to close down any other Microsoft Office applications, 

especially Outlook, while generating a report from MassHunter Quantitative Analysis software. 

 

3.2.8 During quantitative method creation, MRM compounds are labeled 

“Compound_11, Compound_12, etc.” 

 

When creating a quantitative analysis method using the Method-->New-->New 

Method from Acquired MRM Data menu item, the program may create compounds that 

have generic Compound Names (e.g. Compound_11, Compound_12, Compound_13, etc.). 

The correct behavior is to transfer all Compound Names from the Acquisition method (e.g. 

Parathion, Ethoprop, etc.). As a result, the user needs to manually change the generic names to the 

correct names in order to complete part of the method set up. This problem is more likely to 

happen with Acquisition methods that have more compounds and MRM transitions. 

 

The use of generic Compound Names is standard for method setup where the 

Acquisition method does not have Compound Names included (e.g. TOF Scan data). 

 

There is a workaround for this problem.  It involves editing a file that sets quantitative analysis 

method setup defaults: 

 

1) Close MassHunter Quantitative Analysis. 

 

2) Make a copy of the file QuantAnalysis.exe.config in the C:\Program 

Files\Agilent\MassHunter\Workstation\Quant\bin folder. 

 

3) Open C:\Program 

Files\Agilent\MassHunter\Workstation\Quant\bin\QuantAnalysis.exe.config using the 

Notepad editor or an editor specific for XML files. 

 

4) Search for the line 

<add key="UseIndexedDataAccess" value="true"/> 

Change the "true" to "false", i.e. 

<add key="UseIndexedDataAccess" value="false"/> 

 

(Creating the quantitative method using the Method-->New-->New Method from Acquired MRM 

Data menu item will take longer, but the problem will not occur). 
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3.2.9 Index Converter tries to convert TOF or Q-TOF data and takes a very long time 

 

A new feature added in Quantitative Analysis rev. B.03.01 allows QQQ batches to be analyzed 

much faster. Upon adding samples to a batch during its creation, a binary index is created under 

the data file. Unfortunately, under some circumstances the program will try to index TOF or Q-TOF 

data. Accurate mass TOF and Q-TOF is extremely information-rich, much more than QQQ MRM 

data. This fact will cause the program to put up a message that it is converting a data file for a long 

time (greater than 10 minutes) before it times out (e.g. it will show a message like "Converting 

sample file 20090624_039.d (39/60)"). 

 

 
 

The problem will only happen on TOF or Q-TOF data that has not been acquired with Reference 

Mass Correction turned on. The Quantitative Analysis program looks for evidence of Reference 

Mass Correction to tell if the data is QQQ or TOF/Q-TOF. When it does not see any evidence in the 

data file, it treats the TOF or Q-TOF data as if it were QQQ data and indexes it. 

 

The workaround is to acquire TOF and Q-TOF data with Reference Mass Correction turned on, then 

create batches in Quantitative Analysis rev. B.03.01 or B.03.02. If data has already been acquired, 

contact LC/MS Product Support for possible options. 

 

3.2.10 Difficult to threshold TOF and Q-TOF data when creating a quantitative 

method 

 

Because TOF and Q-TOF data are so information-rich, it is useful to ―threshold‖ the data while 

automatically creating a scan method in Quantitative Analysis.  If the user does not do this, it can 

take a very long time to create the method and the user ends up with many extraneous compounds 

for small peaks that they do not care about. 

 

While there is not an explicit user interface to achieve this, there is a workaround to set filters on 

the data while using the New Method from Acquired Scan Data on TOF and Q-TOF data. 

 

1) Open the scan data batch in Quantitative Analysis 
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2) Go to the Method Tasks area 
 

3) Right-click anywhere in the Sample Information window and select Perceive Compound 

Settings. You will get the Scan Analysis Parameters dialog. 
 

4) In the Peak filter field of the Deconvolution tab set the Spectrum peak threshold to a high 

enough value to reduce the number of peaks found. Click OK to apply and cache the value. 
 

 

5) Run "New Method from Acquired Scan Data". The new threshold value will be used. 

 

3.2.11 UserDefined1 through 9 are not transferred from worklist to Quantitative 

Analysis 

 

There is the possibility to set up UserDefined columns in the Acquisition worklist and have them 

transferred to the Quantitative Analysis dataset.  Unfortunately, pre-B.03.02 versions of 

Quantitative Analysis do not do this correctly. 

 

The solution is to upgrade to a version B.03.02 or greater. 
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3.2.12 "Manual integration failed" error while manually integrating in Quantitative 

Analysis 

 

While manually integrating on pre-B.03.02 version, the user may see the following message after 

doing a substantial amount of manual integration in the same session ―Manual integration failed.  

Failed to get compound chromatogram for <compound name>: OpenDataFile is not called prior to 

calling this method.: 

 

 
 

(Note: Text has been deleted in the graphic above to protect the privacy of the user.  The text 

deleted from the error message is the name of the compound that was to be manually integrated). 

 

It is most likely to happen when manually integrating TOF or Q-TOF data batches with many 

samples and compounds (~200).  It will typically occur after one to two hours of constantly 

manually integrating chromatograms. 

 

The problem is caused by a memory issue in versions prior to Quantitative Analysis rev. B.03.02.  

The solution is to upgrade to a version B.03.02 or greater. 

 

3.2.13 Manual integration of ISTD disappears after manually integrating Target 

peak 

 

Users may see the following problem on pre-B.03.02 version of Quantitative Analysis: 

 

1)  Manually integrate a target compound chromatogram in the Compound Information 

Window. 

 

2)  Manually integrate its ISTD in the pane next to the target compound. 
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3) Go back and manually integrate the target chromatogram.  The ISTD chromatogram's 

manual integration disappears.  In addition, you can no longer make any changes to the 

manual integration of the target chromatogram.  If you try, nothing changes. 

 

The solution is to upgrade to a version B.03.02 or greater. 

 

3.2.14 Unable to export more than 256 Batch Table columns to MS Excel 

 

If a user of MassHunter Quantitative Analysis tries to export a Batch Table with more than 256 

columns to MS Excel, it will fail. For example, if they have a Batch Table with the "Display Multiple 

Compounds in Batch Table" selected such that they have more than 256 columns, and then they 

select the File-->Export-->Export Table menu item. They will have the option to save the Batch 

Table as a .xls file. However, after they enter a name and click Save, they will get the error 

message "Excel worksheet is limited to 256 columns, and the batch table exceeds this limit. Please 

adjust the column number to 256 or less in order to export to Excel workbook."  

 

 
 

This problem will occur using both MS Excel 2003 and 2007 (Excel 2003 does not support more 

than 256 columns, thus this restriction was unfortunately hard-coded into Quantitative Analysis). 

 

As a workaround, the user can export the Batch Table (with more than 256 columns) as a .csv 

(comma separated value) file. This .csv file can then be opened in MS Excel and saved as an .xls 

file. However, the user has to remove the Quantitation Message Summary column and Outlier 

Summary column before exporting. These two columns disturb the MS Excel format when the user 

opens the exported .csv file. 

 

3.2.15 Error while installing .NET Framework component during Quantitative 

Analysis installation 

 

During the installation of Quantitative Analysis, the user may see an error while installing the 

Microsoft .NET Framework component.  A specific version of .NET Framework is required by 

MassHunter programs in order to operate. 
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The solution is to open up the Windows Control PanelAdd or Remove Programs and uninstall all 

versions of Microsoft .NET Framework.   

 

 
 

Then install the version on the Quantitative Analysis installation media.  Finally, continue with the 

installation of Quantitative Analysis. 

 

3.2.16 “Relative response is beyond the range of the calibration curve” when 

generating Cal Curve 

 

This error typically occurs while using a Quadratic Fit for a compound‘s Calibration Curve.  It means 

that the response is outside of the range that can be effectively quantitated with that curve fit type.  

For example: 
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The solution is to change to a better curve fit type, e.g. to power law or second-order log fit. 
 

3.2.17 Quantitative Analysis rev. B.03.0x constantly converting data files 

 

 

On revisions B.03.0x, some users noticed that every time they would load a batch it would convert 

the data files in the batch.  In actuality, it should only convert the data files the first time that they 

are added to the batch. 

 

The reason this occurs is if the data files are only in profile mode.  When the Quantitative Analysis 

program converting, it is actually creating an index to speed up access to the data.  Even with 

indexing, profile data takes about ten times as long as centroided data to work with.  The indexer 

runs out of memory trying to index the profile data.   

 

The next time the batch is loaded, Quantitative Analysis notices that it does not have the index 

files and thus tries to convert the data files again.  This is why it is constantly converting the data 

files, but is not successful in doing it. 

 

In revision B.04.00 and later, the indexer does not try to convert profile data, only centroid data.  If 

no centroid data is available, then it does not attempt to convert the profile data. 

 

As a workaround in revisions B.03.0x for data that has already been collected in profile only mode, 

it is possible to turn off the data indexing: 

 

1) Close MassHunter Quantitative Analysis.  

 

2) Make a copy of the file QuantAnalysis.exe.config in the C:\Program 

Files\Agilent\MassHunter\Workstation\Quant\bin folder.  

 

3) Open C:\Program 

Files\Agilent\MassHunter\Workstation\Quant\bin\QuantAnalysis.exe.config using the 

Notepad editor or an editor specific for XML files.  

 

4) Search for the line  

<add key="UseIndexedDataAccess" value="true"/>  

Change the "true" to "false", i.e.  

<add key="UseIndexedDataAccess" value="false"/> 
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3.2.18 Quantitative Analysis converts many different data files, not just the ones in 

the batch 

 

Users will sometimes complain that Quantitative Analysis is converting many data files, not just 

the data files that have been added to a batch.  This has to do with the location of the batch file. 

 

If the user‘s data files are in a folder ―David P. Saturday Runs‖, then the batch should be in a folder 

called QuantResults underneath that, i.e. D:\MassHunter\Data\David P. Saturday 

Runs\QuantResults\Mybatch.quantresult.bin.  When a batch for QQQ data is created or opened in 

Quant B.03.01 or greater, it goes through the conversion process.  The Quant program pre-indexes 

the chromatograms and saves them under the data file folder in a binary file named MSTree.bin (or 

MSTree2.bin for Quant B.04.00 or greater).  This makes the Analyze Batch step five to ten times 

faster. 

 

The Quant program looks one folder above QuantResults to figure out which data files to convert 

(e.g. D:\MassHunter\Data\David P. Saturday Runs).  Once they have been converted, they should 

not be converted again—that step should be skipped.  However, if the batch file is very high up 

(e.g. D:\MassHunter\QuantResults) it will try to convert all data files at that level and in all 

subfolders.  This will take a very long time and is a waste of effort, as they will not be used in the 

current batch. 

 

The solution is to only create new batches at the level of the data files that will be added to the 

batch.  

 

 

3.2.19 Quantitative Analysis rev. B.03.02 crashes when adding samples to batch 

created in rev. B.01.04  

 

Quantitative Analysis rev. B.03.02 may terminate with an error "Failed to enable constraints. One or 

more rows contain values violating non-null, unique, or foreign-key constraints." when adding 

samples to a batch originally created with rev. B.01.04. 

 

The problem will not occur with every batch created with Quantitative Analysis rev. B.01.04.  It will 

also not occur when loading the B.01.04 batch into the older version of Quantitative Analysis rev. 

B.03.01 Build 170.0. 

 

The problem sequence is as follows: 
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1) The user loads a batch originally created in Quantitative Analysis rev. B.01.04 Build 126.0 into 

Quantitative Analysis rev. B.03.02 Build 170.21. 

 

2) The user attempts to add a sample to the batch by selecting the File-->Add Samples menu item. 

 

3) Quantitative Analysis will terminate with a message "Failed to enable constraints. One or more 

rows contain values violating non-null, unique, or foreign-key constraints." 

 

There is a workaround for the problem: 

 

1) Load the batch originally created in Quantitative Analysis rev. B.01.04 into B.03.02 

2) Save a copy of the quantitative method by selecting the Method-->Edit menu item (or F10 

button), then selecting the Save As... button and saving the quantitative method as a 

*.quantmethod.xml file. 

3) Return to the Batch Table view (Exit button) and create a new batch (File-->New Batch menu 

item) 

4) Add all samples of interest to the new batch (File-->Add Samples) 

5) Apply the method from the existing (old) batch (Method-->Open-->Open Method from Existing 

File then select the *.quantmethod.xml file created in Step 2). 

 

 

3.2.20 Problem opening MassHunter Quantitative Analysis rev. B.01.03 batches in 

rev. B.04.00 

 

When the user opens a batch from MassHunter Quantitative Analysis rev. B.01.03 in revision 

B.04.00, the runs in the batch may have Compound Information panes which state "***NO DATA 

POINTS***". 

 

The problem is caused by the conversion of the data to the indexed data format.  The older data 

has an Instrument Type set to "Unknown" (this was fixed in subsequent versions of MassHunter 

Acquisition).  A fix is under investigation to fix the index converter to correctly convert on 

Instrument Type of Unknown. 

 

The workaround is to turn off the indexed converter.  This is done by: 

 

1) Close MassHunter Quantitative Analysis. 

 

2) Make a copy of the file QuantAnalysis.exe.config in the C:\Program  

Files\Agilent\MassHunter\Workstation\Quant\bin folder. 
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3) Open C:\Program 

Files\Agilent\MassHunter\Workstation\Quant\bin\QuantAnalysis.exe.config using the Notepad 

editor or an editor specific for XML files. 

 

Search for the line  

 

<add key="UseIndexedDataAccess" value="true"/> 

 

Change the "true" to "false", i.e. 

 

<add key="UseIndexedDataAccess" value="false"/> 

 

4) Restart MassHunter Quantitative Analysis and begin using it. 

 

The defect was fixed in Quantitative Analysis rev. B.05.00.  However, it is necessary to delete the 

corrupt MSTree2.bin file under each data file‘s \AcqData folder so a new one can be generated. 

 

3.2.21 Quant B.04.00 crashes with positive-negative switching dMRM LC/QQQ 

rev. B.04.01 data 

 

On MassHunter Workstation LC/QQQ Acquisition rev. B.04.01, positive-negative switching dynamic 

MRM (or dMRM) is possible.  However when using MassHunter Quantitative Analysis rev. B.04.00 

and creating batches with positve-negative dMRM data, changing the quantifier in the quant 

method causes Quantitative Analysis to terminate (crash). 

 

The workaround for this problem involves editing a file that sets Quantitative Analysis method 

setup and user interface defaults. The workaround needs to be implemented once for creating the 

quantitative method and then back when reprocessing the data.  To edit this file: 

 

1) Close MassHunter Quantitative Analysis. 

2) Make a copy of the file QuantAnalysis.exe.config in the C:\Program 

Files\Agilent\MassHunter\Workstation\Quant\bin folder. 

3) Open C:\Program 

Files\Agilent\MassHunter\Workstation\Quant\bin\QuantAnalysis.exe.config using the Notepad 

editor or an editor specific for XML files. 

 

Search for the line 
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< add key="UseIndexedDataAccess" value="true"/ > 

 

Change the "true" to "false", i.e. 

 

< add key="UseIndexedDataAccess" value="false"/ > 

 

(Creating the quantitative method using the Method-->New-->New Method from 

Acquired MRM Data menu item will take longer, but the problem will not occur.) 

 

4) Create the quantitative method 

5) Save the method and apply to the batch 

 

(NOTE: At this stage, there is only one transition per compound.) 

 

6) Open again C:\Program 

Files\Agilent\MassHunter\Workstation\Quant\bin\QuantAnalysis.exe.config using the Notepad 

editor or an editor specific for XML files. 

 

Search for the line 

 

< add key="UseIndexedDataAccess" value="false"/ > 

 

Change the "false" back to "true", i.e. 

 

< add key="UseIndexedDataAccess" value="true"/ > 

 

(At this point, all transitions per compound should be visible and changing quantifiers should not 

crash Quantitative Analysis.) 

 

 

3.2.22 6400 QQQ Data acquired with B.04.0x analyzes slower with Pre-B.04.00 

Quant 

 

Data acquired using MassHunter Acquisition for QQQ rev. B.04.0x will process three to five times 

slower using a pre-B.04.00 version of MassHunter Quantitative Analysis.  This means that when a 

user presses the "Analyze Batch" button in MassHunter Quantitative Analysis they will notice that 

it takes three to five times longer to complete than data from a pre-B.04.0x Acquisition for QQQ 

(e.g. B.03.02). 
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The reason is that the previous versions of MassHunter Quantitative Analysis are unable to index 

data from the newer version of MassHunter Acquisition for QQQ.  As a result, it does not create an 

MSTree2.bin file under the *.d\AcqData folder.  When the user presses the "Analyze Batch" 

button, the program must extract the chromatograms from the designated signals in the method 

rather than looking them up in the index created when the samples were added to the batch.  This 

takes much more time. 

 

The solution is to upgrade to MassHunter Quantitative Analysis rev. B.04.00 under Service Note 

G3335AA MASSHUNTER SOFTWARE-62A "Release of Agilent MassHunter Quantitative Analysis 

Software Rev. B.04.00 Build 225.0".  Per that Service Note, the upgrade is provided under warranty 

including time and travel.  It includes all new features and defect fixes for that release. 

 

For Windows XP SP3 and Windows Vista SP2 systems, apply Service Pack 2 (SP2) for MassHunter 

Quantitative Analysis. 

 

For Windows 7 Professional (64-bit) systems, apply Service Pack 3 (SP3) for MassHunter 

Quantitative Analysis. 

 

3.2.23 Quantitative Analysis rev. B.04.00 SP2 is unable to open a batch 

 

A problem has been found where MassHunter Quantitative Analysis rev. B.04.00 SP2 is unable to 

open a batch or create a new batch for specific users.  For some users, when they try to either 

open a batch or create a new batch in MassHunter Quantitative Analysis rev. B.04.00 Service Pack 

2 (SP2), they will see an error message 

 

QuantAnalysis has encountered a problem and needs to close.  We are sorry for the inconvenience.   

 

However, when other Windows users log onto the PC, they will be able to successfully open a 

batch or create a new batch. 

 

The problem is caused by corrupt user-specific files that control the UI display in MassHunter 

Quantitative Analysis rev. B.04.00 SP2.  Reinstalling MassHunter Qualitative Analysis will not fix 

the problem. 

 

To fix the problem: 

 

1) Select the "Restore Default Layout" button in the Batch Table view which appears when 

MassHunter Quantitative Analysis starts up.  Then try to open a batch or create a new batch. 
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If 1) above does not fix the problem 

 

2) Delete the corrupt files so they can be recreated with default values 

a) Shutdown MassHunter Quantitative Analysis 

b) Delete the files in the folder  

 

C:\Documents and Settings\<user name>\Application Data\Agilent 

Technologies_Inc\QuantAnalysis.exe\4.0.225.19 

 

(where "user name" is the name of the user currently logged into Windows, e.g. Administrator.) 

 

c) Restart MassHunter Quantitative Analysis.  The files will have been recreated and the user 

should now be able to open batches and create new batches. 

 

 

3.2.24 Problem that qualifiers are not drawn to scale 

 

In a targeted compound analysis, whether the data is acquired on a TOF, Q-TOF or QQQ, one of the 

steps in the confirmation process is to view the Quantifier and Qualifier ion ratios and make certain 

that the ratios are within a specified range.  In MassHunter Quantitative Analysis, the default view 

is in the ‗Normalize‘ view.  The default view gives an image like this: 
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Although the header in the qualifier window (right window) indicates that the ratio between the 

quantifier ion (127.0  109.0 transition) and the qualifier (127.095.0 transition) is 32.2 and this is 

96.8 of the expected ratio, the graphic representation does not indicate this ratio. 

 

To change this situation, right click on the qualifier window and go to Properties. 
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Remove the Normalize checkbox (red arrow), click Apply and OK and the new window shows the 

desired graphic representation with the ions drawn to scale for faster visual inspection: 
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3.3  Qualitative Analysis 
 

3.3.1 Qualitative Analysis (pre-B.04.00) is unable to run in 64 bit Windows 

 

The Qualitative Analysis program (pre-B.04.00) is unable to run in 64 bit versions of the Microsoft 

Windows programs.  When a user tries to run Qualitative Analysis on a 64 bit version, when the 

Open Data File dialog comes up they will see an error message ―Failed to read the Workflow name 

from the external file at c:\agilent\configuration\QualWorkflowConfiguration.txt‖ 

 

 
 

The solution is to instead install Qualitative Analysis (pre-B.04.00) on one of the supported versions 

of 32 bit Microsoft Windows or upgrade to rev. B.04.00 or greater. 

 

3.3.2 Dropouts in baseline using centroid data in Qualitative Analysis  

 

This problem can be caused by having an ion which is just at the edge of the acquired mass range.  

At certain points, the baseline will show sudden drops which then will quickly restore themselves: 
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This is because the ion at the edge occasionally is not condensed into the range of the detected 

ions.  This will especially apparent if that ion is one of the major ions. 

 

The solution is to change the scan range settings in Acquisition.  If the ion is important, than the 

range should be extended say, 10 amu more than the ion.  If the ion is considered noise, then the 

scan range should be narrowed 5 amu away from the ion. 

 

3.3.3 “NO DATA POINTS” when extracting peak spectra 

 

This problem can occur depending on the method settings if TOF data is saturated (i.e. above the 

readable values for the TOF‘s detector).  For example, in the situation below the user is trying to 

Extract Peak Spectra from a TIC.  The MS Spectrum Results Windows displays ―NO DATA 

POINTS‖: 
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If the user turns on Walk the Chromatogram and pulls up the spectrum closest to the apex of the 

chromatographic peak, they will see that the two most abundant ions are saturated (they are 

labeled with an asterisk (*): 
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There are two possible choices for a solution: 
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1) Adjust the Qualitative Analysis method parameters to not require that spectra are 

excluded if they are above a threshold of saturation (not recommended): 

 

 
 

2) Change the Acquisition conditions to not acquire saturated spectra. 

 

3.3.4 Not enough compounds found during Molecular Feature Extraction (MFE) 

 

The Molecular Feature Extraction (MFE) algorithm surveys MS data and pulls out ―features‖ which 

map to chemical compounds.  The user can then do further processing of the compounds, e.g. 

Molecular Formula Generation (MFG). 

 

In some cases, a user will perform MFE on some data and find very few or no compounds at all.  At 

this point, it is important to do two things: 

 

1) Inspect the MS data to make sure it is not saturated.  Saturated data has poor mass 

accuracy, which interferes with the MFE algorithm‘s ability to pull out features.  You can do 

this by pulling up spectra from the data file and making sure that the most abundant mass 
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peaks do not have an asterisk (*) next to them.  This means it has exceeded the range of 

the TOF detector and the user should adjust the sample amount introduced. 

2) If the data do not indicated saturation, carefully inspect each of the MFE parameters to 

make sure that none are set to erroneous values. 

 

Some typical problems with MFE parameters are: 

 

 
 

Target data type is set to the wrong value (for example, to Large molecules when the user is 

extracting small, chromatographic data. 
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Ion Species are incorrect (ions are not selected as Allowed ion species or M+H is not the 

dominant ion so ―Salt dominated positive ions‖ is not selected). 
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Mass Filters are set to filter by a Database which does not contain any of the features of 

interest—the user should deselect the ―Filter mass list‖ button and try MFE again not filtering any 

data by mass. 

 

3.3.5 “Too many” compounds found during Molecular Feature Extraction 

 

A user may complain that they ran MFE on a ―pure‖ sample (e.g. caffeine) but found many 

compounds.  The function of MFE is not to be selective but to cast a wide net and try to identify as 

many compounds as possible (given the parameters).  For the example of caffeine, the ―pure‖ 

compound may be the major component, but there will be other components including (but not 

limited to), the methylene chloride used to extract it from the coffee or tea leaves, the reaction 

byproducts,  breakdown products of caffeine, contaminates that are in the mobile phase, 

metabolites from microorganisms that contaminated the coffee/tea mixture, etc. 

 

If a user wants to limit the number of compounds found during MFE, the best way to do it is with 

the Compound Filters tab in the MFE parameters: 
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For example, they could limit to the largest 5 compounds found. 

 

3.3.6 Find by AutoMSMS and then MFG gives the wrong or no formula 

 

In this case, the user runs Find by AutoMSMS on Q-TOF data, then performs Molecular Formula 

Generation (MFG) on the Compounds found.  MFG finds either the wrong formula, or no formula at 

all.  It is possible that finding Compounds by Molecular Feature Extraction (MFE) and then MFG 

may find the right formula. 

 

The cause is that the Acquisition settings are incorrect for what they want to achieve.  For 

example, if the Isolation Width MS/MS is set to Narrow: 
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Then the Find by AutoMSMS would not find all of the isotopes.  Missing these isotopes throws off 

MFG such that it would get an incorrect or no formula.  The solution is to change the Isolation 

Width to a wider value like Medium. 

 

3.3.7 Problems using Molecular Formula Generation (MFG) on regular and 

halogenated compounds 

 

In MassHunter Qualitative Analysis, once the user has generated a compound it is possible to run 

Molecular Formula Generation (MFG) on the compound. This can provide the user with a set of 

candidate molecular formulas for the compound. 

 

However, some earlier versions of the MFG algorithm would not find some valid compounds.  The 

reason is that in order to search the ―formula space‖ more efficiently, the algorithm would restrict 

the size of the ―formula space‖ with some rules.  These rules turned out to be overly restrictive and 

ended up excluding some valid formulas, especially for halogenated compounds. 

 



 

Author:  Steve Madden Agilent Restricted Page 50 of 92    
LC/MS Product Support 
Version 2.0 – September 1, 2011  Printed Copies are Uncontrolled 

Organometallic compounds present special problems for MFG vs. regular organic compounds.  

These often involve the need to tweak the input parameters in order to get correct results, usually 

around the Isotope Model and MS ion electron state.  For more details, see the Agilent publication 

5989-7409EN ―Superior Molecular Formula Generation from Accurate-Mass Data‖ available in 

LSCA eLibrary and the article ―Molecular Formula Generation on Organometallic Compounds‖ in 

LC/MS Support News # 202. 

 

3.3.9 Error occurs during Extract Peak Spectra (UV) “Object reference not set to 

an instance of an object.” 

 

This error will occur on pre-B.03.01 versions of Qualitative Analysis when extracting peak spectra if 

there is not an UV spectrum at the apex of the UV peak.  This may occur if the UV data points are 

being acquired at a slow rate (e.g. one spectrum for every 6 to 16 UV data points).  When 

MassHunter goes to the apex of the UV peak to extract a spectrum, it does not find one there and 

throws this exception.  For B.03.01 and greater, it will simply extract an empty spectrum and not 

create an error. 

 

The workaround is to change the integrator settings to not integrate the UV peak without the 

spectrum at the apex (it will typically be small).   

 

The solution is to change the UV acquisition settings to acquire UV spectra more frequently to 

reduce the chance that a peak would be created without a UV spectrum at its apex. 

 

3.3.10 User interface is missing expected dialogs and/or panels 

 

This problem might present itself by the user complaining that some UI element is missing, for 

example they are unable to extract UV spectra because there are not tabs with parameters to set 

that up.  The most common cause of this problem is that the particular technique is not configured 

in the User Interface Configuration dialog, available from the ToolsUser Interface Configuration 

menu item: 
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3.3.11 Error during Find by Formula “not enough elements in parent molecule to 

subtract from” 

 

This error message may occur while doing Find by Formula using Qualitative Analysis rev. B.02.00 

on compounds which have formulas with no hydrogens (e.g. some pesticides).   
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If the user has enabled in their method the –H deduct ion, and Find by Formula attempts to 

subtract a hydrogen from a formula without any hydrogens in it, the algorithm fails.  The problem is 

fixed in Qualitative Analysis rev. B.03.01 and greater. 

 

The workaround for Qualitative Analysis rev. B.02.00 is to remove the M-H deduct ion from the 

Negative Ions tab and save the method: 

 

 
 

3.3.12 Error “PCDL may not be installed on this system” when library searching 

 

When running an Accurate Mass Library search in Qualitative Analysis, the user may see an error 

message like ―C:\MassHunter\Library\SulfasLib.cdb cannot be loaded.  PCDL may not be installed 

on this system.‖   

 

 
 

This will only happen when searching CDB format libraries introduced with Qualitative Analysis 

rev. B.03.01, not the older CSV and MTL formats.  The reason for this error message is that the PC 
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with Qualitative Analysis does not have correct version of Microsoft SQL Compact Edition installed.  

This component is necessary to search CDB format libraries.  It is installed (if not already present) 

when installing the Personal Compound Database and Library (PCDL).  PCDL is the database and 

library editor for accurate mass data. 

 

To get rid of this error message, install PCDL on the PC. 
 

3.3.13 User interface elements are missing from a particular user account 

 

This problem may occur when one Windows user logs into the PC (e.g. Admin) and is able to see 

particular user interface elements that another user cannot.  For example, if a user can see the 

Chromatogram Peak Survey workflow but another user on the same PC cannot. 

 

The problem is caused by the user-specific files becoming corrupt.  The solution is to restore them 

to defaults by: 

 

1. Shutting down MassHunter Qualitative Analysis 

2. Navigating to the folder C:\Documents and Settings\<Windows user name>\Application 

Data\Agilent Technologies, Inc\and delete the CoreDefinitions and QualDefinitions folders. 

3. Restarting MassHunter Qualitative Analysis.  The user-specific files will be recreated with 

default values. 

 

3.3.14 Error “There are no chromatograms currently highlighted” when opening 

data file or running worklist 
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This error message occurs because the Define Chromatograms area has no chromatograms 

defined that can be extracted: 

 

 

 
 

When the user either opens a data file with the ―Run ‗File Open‘ actions from selected method‖ 

checkbox checked, or runs a worklist, one of the typical actions is ―Extract Defined 

Chromatograms‖.  However, since no chromatogram is defined then none is extracted. 

 

The next action like ―Integrate and Extract Peak Spectra‖ attempts to operate on a chromatogram 

highlighted in the Data Navigator that does not exist.  As a result, it returns this error message.   

 

The solution is to define a chromatogram for the method in the Define chromatograms field by 

pressing the Add button. 

 

3.3.15 BioConfirm differences in mole fractions 

 

The BioConfirm application uses mole fraction information from the U.S. National Institute of 

Standards and Testing (NIST).  In some cases, customers have reported that there are slight 
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differences in results vs. other tools (e.g. Expasy) because those tools use values from a different 

standard setting organization.  For example, the numbers for MoleFraction for C12 differ between 

NIST and IUPAC: 

 

NIST                        98.89% 

IUPAC                    98.93% 

 

IUPAC reports that its value can vary due to natural occurrence of isotopes by up to 0.08%.  This is 

in fact how carbon dating of fossils, etc is done—by analyzing the proportion of carbon isotopes in 

the samples.  Unfortunately, there is no easy solution for these mole fraction differences because 

they reflect the values in the natural world. 

 

3.3.16 Error “Retention time values must be monotonically increasing”  

 

This error will typically occur while loading a data file in Qualitative Analysis.  One possible cause 

is creating snapshots in Dynamic MRM (dMRM) mode.  The solution is to not do this, but instead 

to wait until the data file is done acquiring. 

 

 

3.3.17 Error while installing Qualitative Analysis Service Pack 

 

While trying to install a Qualitative Analysis Service Pack, a user saw the following error: 

 

 
 

It was determined that the cause of the error was the customer‘s anti-virus software.  The user 

temporarily disabled his anti-virus software and could then successfully install the Service Pack. 

3.3.18 Error when trying to uninstall Qualitative Analysis 

 

One error seen when trying to uninstall or repair Qualitative Analysis is ―Installshield Error 1628: 

Failed to complete script based install‖.  To get rid of the error message, try the following: 
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1) Reboot the PC. 

2) Delete temporary files; that is, all files in C:\Windows\Temp. 

3) Try again. 

 

Another problem due to an incomplete uninstallation of MassHunter Qualitative Analysis was 

when the user started up Qual they saw this error message: 

 

 
 

When they pressed OK, the user then saw: 

 

 
 

The cause was that the .NET Framework 2.0 had become corrupted and could neither be installed 

nor uninstalled.  The solution was to delete all MassHunter folders and run a Microsoft tool called 

the .NET Framework Cleanup Tool available from: 

 

http://blogs.msdn.com/b/astebner/archive/2008/08/28/8904493.aspx 

 

The user then installed Qualitative Analysis and was able to use it successfully. 

 

 

http://blogs.msdn.com/b/astebner/archive/2008/08/28/8904493.aspx
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3.3.19 Error “Unable to read file” when installing, uninstalling or generating 

reports 

 

While installing, uninstalling or generating Excel-based reports with MassHunter Qualitative 

Analysis, the user may see an error message of ―Unable to read file‖: 

 

 
 

If the user is generated an Excel-based report, then clicking OK will cause the report to be 

generated as normal. 

 

This problem is typically caused by a temporary copy of the MassHunter Reporting Qualitative 

Analysis Add-in in the C:\Program Files\Microsoft Office\Office12\Library folder.  The temporary 

Add-in usually has ―~$‖ appended to the front of it, e.g. ~$MassHunter Reporting Qual.xlam.  Excel 

is complaining that it is unable to read the corrupted Add-in. 

 

First, shut down MS Excel and Qualitative Analysis completely (This step is very 

important! You do not want to accidently delete a valid temporary add-in). Make 

sure MS Excel is completely shut down by opening the Windows Task Manager (using 

the Ctl-Alt-Delete keys and pressing the Task Manager button). In the Processes tab find 

any processes named EXCEL.EXE, highlight them, and press the End Process button. 

Press Yes to any warning asking you if you really want to terminate the process. 

 

Finally, go to the C:\Program Files\Microsoft Office\Office12\Library folder and delete the file 

~$MassHunter Reporting Qual.xlam. It should be very small (1-2 KB). 

 

3.3.20 Qualitative Analysis hangs when opening data file with saved results 

 

When a user installs Quantitative Analysis rev. B.04.00 and then opens Qualitative the software 

may hang like below: 
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The reason is that Quantitative Analysis rev. B.04.00 installs Microsoft .NET Framework 3.5 SP1. 

Microsoft designed the .NET Framework as a programming platform for Windows 

applications.  One of its design goals is that different revisions of the .NET Framework should be 

installed and run independently on the same PC.  For example, MassHunter Qualitative Analysis 

revisions B.03.01 and 4.00 install and use .NET Framework 2.0. 

 

Unfortunately, the Quantitative Analysis rev. B.04.00 version of .NET Framework (3.5 SP1) ―breaks‖ 

a functionality in other versions.  The symptom in MassHunter Qualitative Analysis is that when 

opening a data file with saved results, the operation will freeze with the progress bar at 

approximately 95%.  The problem could happen anytime .NET Framework 3.5 SP1 is installed (e.g. 

for a different application on the PC besides Quantitative Analysis).  In order to correct this 

behavior please follow the instructions in Service note G3335AA MASSHUNTER SOFTWARE-50 

and download the Microsoft HotFix for the problem: 
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3.3.21 Error when running “Find Targets by: MFE + Database Search” Wizard 

 

One of the features added with MassHunter Qualitative Analysis rev. B.04.00 is the ―Find Targets 

by: MFE + Database Search‖ Wizard. On some PCs, when it is run it will fail with the error 

message: "Qualitative Analysis has encountered a problem and needs to close. We are sorry for 

the inconvenience" 

 

The problem is due to a Microsoft issue with .NET Framework 2.0 SP2.  

 

Microsoft has posted a HotFix for the problem at:  

http://support.microsoft.com/kb/972259 

 

Shut down MassHunter Qualitative Analysis and execute the two files in the ZIP file. Then restart 

MassHunter Qualitative Analysis and begin using it. 

  

http://support.microsoft.com/kb/972259
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3.3.22 Mass peaks are not labeled in mass spectrum 

 

In this mass spectrum, the mass peaks on the left side of the apex are not labeled: 

 

 
 

This is because the centroiding algorithm (which is the same as the peak labeling algorithm—it is 

the ―peak picker‖) walks up the peak looking for the apex.  If the signal does not go down enough 

(the default is 40 % of the height of the proposed apex), it continues looking for the apex.  In this 

case, it found the apex at 2055.4392 and labeled it.  It then found some other minor peaks with a 

valley less than 40% along the slope of the major peak.  It is a lot easier to go down below 40% on 

the downslope of a peak than an upslope.   

 

It is possible by tweaking parameters to make the minor peaks on the upslope be labeled.  If the 

Required Valley parameter is set to 0.9, a lot more show up: 
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3.3.23 Differences in extraction of profile and centroid data with the same 

extraction window 

 

Occasionally, there will be questions from field about extracting chromatograms in Qualitative 

Analysis in either centroid (aka peak-detected) or profile mode.  Profile is the entire set of data 

points from the Smartcard, such that when you zoom into a mass peak it looks like a 

chromatographic peak: 
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Centroid is a summarizing of these data points into a dimensionless line for each mass peak: 

 

 

One way of visualizing the calculation of centroids is to imagine if you were to print a profile 

spectrum and cut out all the mass peaks with scissors. Then if you took each peak and balanced it 

on the edge of a knife, the line where the blade touched the paper would be the weighted center of 

mass, the centroid. 

 

In MassHunter Qualitative Analysis, it is possible to set in the method whether profile or centroid 

data will be used; this is in the SpectrumExtraction Data Format pane: 
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(Prior to Qualitative Analysis rev. B.04.00, this was in the GeneralExtraction Data Format pane). 

 

When the user extracts chromatograms from a data file, a slightly different algorithm is used 

depending on whether centroid or profile data is being extracted.  This can become especially 

apparent if the user sets an extremely small extraction window, e.g. +/- 1.0 ppm in the Single m/z 

expansion for this chromatogram field: 
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For example, if the example data file sulfas_PosMS.d (which contains both centroid and profile data) is 

extracted as centroid at 311.1150 m/z +/- 1.0 ppm  (311.1147 to 311.1153) it will show ZERO 

ABUNDANCE: 

 

If it is extracted as profile at 311.1150 m/z +/- 1.0 ppm (311.1147 to 311.1153) it shows a well-

defined chromatographic peak at 1.225 min: 
 

 

Looking at the centroid spectrum at 1.225 min we see that there is no data in the range of 311.1147 

to 311.1153 m/z (+/- 1.0 ppm): 
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However, looking at the profile spectrum under the same conditions we see that there is a 

response at that m/z: 

 

 

For extremely narrow extraction windows, the extraction of profile data will actually ―snap to‖ the 

nearest data point, even if the point is not within the extraction window (e.g. there are no data 

points in the range 311.1147 to 311.1153 m/z).  It will use the abundance of this nearest data point 

to create the chromatographic peak, not of the data point at the apex of the mass peak.  If the 

extraction window includes two or more data points it will sum these data points to create the 

chromatogram. 

 

As a result, when the user extracts EICs with a narrow extraction window, they may see 

differences between centroid and profile data.  These differences become less as the extraction 

window becomes wider as both centroid and profile data chromatogram extractions include more 

data points. 
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3.3.24 Unable to display SIM chromatograms in Qualitative Analysis rev. B.03.01 

 

When the user extracts chromatograms in MassHunter Qualitative Analysis rev. B.03.01 (by right-

clicking on a chromatogram and choosing the Extract Chromatograms menu item) they have the 

choice of different type of chromatograms to extract.  If they choose "SIM" in the Type dropdown, 

and then "All" in the SIM ion dropdown, they may see that some of the SIM chromatograms 

extracted are labeled "***ZERO ABUNDANCE***".   

 

The workaround is to extract the individual signals by selecting each one in the SIM ion dropdown 

and extracting its chromatogram. 

 

The defect is fixed in Qualitative Analysis rev. B.04.00. 

 

3.3.25 Error upon opening the Recalibration dialog box in Qualitative Analysis rev. 

B.03.01 

 

Qualitative Analysis has the capability of recalibrating TOF or Q-TOF data.  This will allow the user 

to select a mass list and perform a manual recalibration of the tuning to reduce the mass error.  

However, under certain circumstances when the user tries to open the Recalibration dialog (by 

right-clicking on a spectrum and selecting Recalibrate) an error may occur.  This error is  

 

Program: Agilent MassHunter Workstation Software Qualitative Analysis B.03.01 

Build Configuration: Release 

Message: Object reference not set to an instance of an object. 

 

The problem is caused by leaving the Recalibration dialog open when shutting Qualitative Analysis 

rev. B.03.01 down.  The next time that Qualitative Analysis starts up and the user tries to open the 

Recalibration dialog, they will see the error message. 

 

The workaround is to close the Recalibration dialog (by clicking on the X in the upper right corner) 

prior to shutting down Qualitative Analysis.  The defect is fixed in Qualitative Analysis rev. B.03.01 

Service Pack 3 (SP3).  See Service Note G3335AA MASSHUNTER SOFTWARE-63 for details. 

 

 

3.3.26 Error when running Find by Formula with CEF file as Formula Source in 

Qualitative Analysis rev. B.04.00 
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In MassHunter Qualitative Analysis rev. B.04.00 while running Find Compounds by Formula using a 

CEF file as the Formula Source (aka "Find by Ion") an error may occur.  The error is ―Object 

reference not set to an instance of an object.‖  The Find Compounds by Formula operation will 

terminate with no results (compounds).  

 

The problem does not occur while using MassHunter Qualitative Analysis rev. B.03.01.  Find by Ion 

is a very common operation for customers using Mass Profiler Professional (MPP) who wish to do 

recursion in MassHunter Qualitative Analysis.  The problem will not occur on all data sets, but is 

possible in those containing CEF files with compounds that have multiple adducts (e.g. M+H+K+1). 

 

The defect is fixed in Qualitative Analysis rev. B.04.00 Service Pack 2 (SP2).  See Service Note 

G3335AA MASSHUNTER SOFTWARE-109 for details. 

 

 

3.3.27 Problem that graphics are “clipped” in Qualitative Analysis on Windows 7 

 

There have been reports on non-Agilent bundle PCs that graphics in MassHunter Qualitative Analysis are 

“clipped off.”  For example in the Find Compounds by Molecular Feature’s Ion Species tab they are 

missing the checkboxes to select the adducts for Negative ions and Neutral losses: 

 

 

 

In addition, the bottom portion of the Open File dialog is missing: 
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(Note: Text has been deleted in the graphic above to protect the privacy of the user).  

Investigation has determined that the problem is caused by the Dots Per Inch (DPI) setting in Windows 

7.  The default setting (as set on Agilent bundle PCs) is Smaller - 100%.  When the DPI is set to other 

values in Windows 7 (like Medium – 125%) the distortion in Qualitative Analysis occurs. 

To examine and change the DPI setting, right-click on the Windows Desktop and select Screen 

resolution.  In the Screen Resolution dialog, choose Make text and other items larger or smaller: 

 

Deleted Text 

Deleted 

Text 



 

Author:  Steve Madden Agilent Restricted Page 69 of 92    
LC/MS Product Support 
Version 2.0 – September 1, 2011  Printed Copies are Uncontrolled 

 

 

In the Display dialog, if the value is other than 100%, change it to 100%.  
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This should make the graphics problems go away.   

 

3.3.28 Performance problems that are solved by upgrading to Windows 7 

 

There have been some performance problems with Qualitative Analysis when using some of the 

more data-intensive algorithms like Molecular Feature Extraction (MFE), and Find by Formula.  It 

has been found that performance is improved with Qualitative Analysis rev. B.04.00 when using 

Windows 7 Professional 64-bit.   

 

For a customer data set running MFE on an 85 minute Q-TOF run: 

 

Operating System RAM Result 

Windows XP SP3 32-bit 4 GB System out of memory error 

Windows 7 Professional 64-bit  8 GB Finished and found 2774 compounds 

 

For an internal metabolomics data set containing 53 data files run in a worklist with MFE and 

export to CEF:  
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Operating System RAM Result 

Windows XP SP3 32-bit 4 GB Failed at least once during the worklist 

Windows 7 Professional 64-bit  8 GB Always completed 

 

(Please note that Windows XP 32-bit cannot use more than 4 GB of RAM.  Windows 7 Professional 

64-bit can use up to 192 GB of RAM.) 

 

For more details, see Service Note G3335AA MASSHUNTER SOFTWARE-102. 

 

3.3.29 Generating and saving results takes a very long time for Molecular Feature 

Extraction (MFE) 

 

Sometimes when doing Molecular Feature Extraction (MFE), users will encounter a problem that it 

takes a very long time (hours) to generate results.  Then when they save the results to the hard 

disk in Qualitative Analysis, it can also take hours before they can use Qualitative Analysis again.  

Occasionally, they will find that the process will stop with an out of memory error. 

 

This is more likely to happen when doing MFE and extracting MS/MS spectra.  The problem with 

the results is that the MS/MS spectra have many many mass peaks.   The huge amount of 

MS/MS mass peaks is not a problem for the MFE or other algorithms, but when the algorithms go 

to extract the MS/MS spectra the memory on the PC is filling up. 

 

The solution is to use the MS and MS/MS peak filters to restrict the Product Ion spectra for 

results to 100 mass peaks.  There is no loss of data for the user because it does not affect the 

operation of the algorithm, just how many mass peaks get extracted and placed in the Product Ion 

spectra in the Data Navigator‘s results.  To restrict them, use the SpectrumàExtract(MS) and 

Extract(MS/MS) areas in the Method Editor.  Check the box in the Peak Filters tab for Limit (by 

height) to the largest and enter 100 in the field: 
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This will speed up both the running of the MFE algorithm and the saving of results in Qualitative 

Analysis. 
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3.4 MassHunter Reporting  
 

Note: The MassHunter Reporting User Information CD (P/N G6845-60005) that ships with every 

MassHunter software kit contains a significant amount of troubleshooting information for reports.  

This is usually found in the Tips and Troubleshooting section of each lesson.  The CD is also 

available through Agilent SubscribeNet. 

 

3.4.1 MS Excel may cause a reboot during reporting when using the PCL6 printer 

driver 

 

When using a PCL6 printer driver, there is a problem that the system will reboot when printing from 

MassHunter Workstation Qualitative Analysis software.  One solution is to go back to the PCL5 

driver which shipped with the system originally. 

 

There is a printer driver setting that causes this, so changing it may make the problem go away. 

HP P3005d Printer 

Select ‗Start‘  ‗Settings‘  ‗Printers and Faxes‘ 

 

Choose the desired printer, right-click on it and choose ‗Printing Preferences…‘ 
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In the resulting window, choose the ‗Advanced‘ tab and then change the ‗Print Optimizations:‘ 

from the default ‗Enabled‘ to ‗Disabled‘. Click ‗OK‘ and you are done.  

HP LaserJet 2200d 

Select ‗Start‘  ‗Settings‘  ‗Printers and Faxes‘ 

 

 

Right-click on the desired printer and choose ‗Printing Preferences…‘ 
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Choose the ‗Advanced…‘ button on the ‗Layout‘ tab 

 

Choose the ‗Print Optimizations:‘ option and change from ‗Enabled‘ to ‗Disabled‘. Click OK. 

 

3.4.2 Printer will not print complete report and job eventually needs to be deleted 

 

This problem exhibits itself in that a printer will report that it is attached to a port named ―DOT4‖.  

MassHunter reports will not print correctly under these conditions—it will print three pages, then 

the job will need to be deleted.  After a couple times of deleting printer jobs, MassHunter or 

Windows needs to be restarted. 

The problem appears to happen when the user attaches the printer to the PC Workstation using a 

USB port.  In some cases, when the printer is attached to the PC Windows reports: 

Found new hardware 

Created new virtual port "DOT4 USB" 
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Also created HP LJ2420 (Copy1), attached to Virtual Port DOT4 USB. 

The solution is to use Control PanelPrinters and Faxes to change the printer port from DOT4 to 

the regular USB port.  Reports should then print normally. 

 

3.4.3 MassHunter will not print report in PDF format 

For this problem, when the user attempts to print a report and selects the PDF format in 

MassHunter, it will not print the report (no PDF file is created).  The most common reason is that 

the user has not installed the PDF Add-in to enable Print to PDF.  This is required in order to print 

to PDF from MassHunter.  In many MassHunter installations, a reminder screen pops up at the end 

of the installation to tell the user to install the Add-in.  Licensing rules for the Add-in do not allow 

the installer to install the PDF Add-in as part of the MassHunter installation. 

 

3.4.4 MassHunter reports are not generated after installing MS Excel 2003 

 

This problem is typically caused by installing the wrong version of Microsoft Excel 2003.  The only 

version of MS Excel 2003 that will work with MassHunter reports is MS Excel 2003 Professional.  

This version has the MS Excel components to manipulate the XML files used by MassHunter for 

reporting.  MS Excel 2003 Standard will not work.  No reports will be generated. 

 

For more information on the different version of MS Excel 2003 and how to identify them in the 

box, please see the article in ―Why We Need Excel 2003 Professional and Why Excel 2007 Is 

Different‖ in LC/MS Support News # 190. 

 

There is only one version of MS Excel 2007 and it has all necessary components for MassHunter 

Reporting. 

 

3.4.5 Extra blank page is printed with every report 

 

This is usually caused by there being too much text for the width of the page in the template so it 

wraps around.  If it is completely blank, then it might be a case where it is just the slightest bit 

over.  One possibility is if the user is accidently using a Letter template on A4 paper, as the Letter 

size is slightly wider than the A4.  Check the template used vs. the paper size. 

 

If this is not the case, the template may have been modified (e.g. had an extra column added) so 

that the template wraps around.  Open the MS Excel template for that report, select Process Report 

in the Add-ins tab, and Browse to a report.results.xml file: 
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(Instructions on how to do this in text and video are available in the MassHunter Reporting User 

Information CD (P/N G6845-60005) that ships with every MassHunter software kit).  Once a report 

has been created, select the Print Preview function in MS Excel (Office ButtonPrintPrint 

Preview) to see if an extra page is created.  If so, modify the template by reducing the set widths of 

the columns until the extra page is no longer created. 

 

3.4.6 Edits to fields in a MassHunter Reporting template‟s table have no effect 

 

With this problem, the user is trying to edit a field in a MassHunter Reporting template, e.g. to 

create a function in a specific field.  The change can never be saved to the template. 

 

The reason is that the table ―collapses‖ such that the row that the formula would be placed into is 

not visible to the user.  The user tries to edit the row beneath the table—which is not part of the 

table. 
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The solution is to expand the row to make it visible, then edit and save the template. 

 

 
 

3.4.7 Changes to A4 templates for Qualitative Analysis cause an error when 

printing a report 

 

This problem exhibits itself as the following: a Qualitative Analysis report template is changed, for 

example by adding the Areasumpercent from the XML source, the template is saved, but when you 

print a report an error will appear ―The following error occurred while generating a report for the 

file <data file name>.  One or more values in ‗Report templates‘ are invalid.  Change values of 

‗Report templates‘ and try again‖: 

 

 
  

If the user places the template in D:\MassHunter\Report Templates\Qual\A4 and do not have a 

copy of the same template in …\Qual\Letter, this error will occur.  The workaround is to place a 

copy of the same modified template in both directories, ..\Qual\A4 and ..\Qual\Letter. 

 

The solution is to upgrade to a minimum of Qualitative Analysis rev. B.02.00 Service Pack 3 (SP3) 

Build 197.7.  See Service Note G3335AA MASSHUNTER SOFTWARE-35A for details on SP3. 

Row 27 is not visible between rows 26 

and 28.  The user tries to edit row 28, 

which is actually not part of the table. 
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3.4.8 MassHunter report graphics appear “clipped” at the top of peaks 

 

This problem is actually not caused by reports or the printer, but by having saturated TOF data.  It 

has erroneously been attributed to MassHunter Reporting. 

 

 
 

(Note: Text has been deleted in the graphic above to protect the privacy of the user). 

 

Viewing the data in Qualitative Analysis and pulling up a spectrum from the ―clipped‖, flat apex of 

the peak shows that it is saturated: 

 

Deleted Text Deleted 

Text 
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You can see above that the data is saturated as the most abundant mass peaks have an asterisk 

(*) next to them.  This means it has exceeded the range of the TOF detector. 

 

The solution is to introduce less of the analyte so that the detector is not saturated. 

 

3.4.9 MS Excel Add-ins tab has no menus or is grayed out and unusable 

 

This problem occurs when the user opens a MassHunter Reporting template and finds that the 

Add-ins tab in Microsoft Excel either has no menus: 

 

 
 

or is grayed out: 

 



 

Author:  Steve Madden Agilent Restricted Page 81 of 92    
LC/MS Product Support 
Version 2.0 – September 1, 2011  Printed Copies are Uncontrolled 

 
 

As a result, the user is unable to use any of its features. 

 

There are several possible reasons for this behavior. 

 

1) VBA was not installed when Microsoft Excel was installed 

 

VBA is installed during the normal MS Excel installation.  However, if the user installs 

Microsoft Office instead or MS Excel from the Microsoft Office DVD, they need to 

specifically install VBA or the Add-ins are unable to be loaded.  The solution is to follow the 

instructions in the MassHunter software installation guide on how to install VBA when 

Excel is installed from Microsoft Office. 

 

2) A valid MassHunter template was not opened 

Unless an actual template is opened, the Add-ins tab‘s menus will not be active.  The user 

should check that they have actually opened a template. 

 

3) The Add-ins are not checked in the Add-ins dialog box 

 

If the Add-ins in the Add-ins dialog box are unchecked they will not be loaded when a 

template is opened.  See the instructions for installing and setting up MS Excel in the 

MassHunter software installation guide about checking the Add-ins to prepare the system 

for MassHunter Reporting. 
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In some cases, the problem of grayed out menus is able to be cleared up by simply restarting 

MS Excel and reloading the MassHunter Reporting template.  It is possible that for some 

reason in that instance the Add-in did not load correctly and a restart clears the issue. 

 

3.4.10 Changes to MS Excel Add-ins are not saved 

 

For this problem, the user checks Add-ins in MS Excel but finds later that they have become 

unchecked.  As a result, MassHunter Reporting may not generate reports.  There are two possible 

causes for this. 

 

1) Security software has changed the MS Excel settings 

 

Some companies run security and virus scanning software on Workstation PCs which may 

make changes to the Add-ins status.  In addition, it is possible that Microsoft Updates may 

clear the Add-ins that are checked.  The user needs to go back and recheck the Add-ins. 

 

2) Changes were made to MS Excel while a MassHunter application was still running 

 

It has been found that if a MassHunter application is running while modifying setting in MS 

Excel, especially for Add-ins, the changes may not be saved when exiting MS Excel.  The 
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solution is to make sure to shut down all running MassHunter applications prior to starting 

up MS Excel to make changes to it. 

 

3.4.11 MS Excel gives error “Programmatic access to Visual Basic Project is not 

trusted” during MassHunter Reporting 

 

This error will typically occur because the security settings are not correctly set in MS Excel: 

 

 
 

The cause is that the ―Trust access to the VBA project object model‖ check box is unchecked in 

the MS Excel Trust Center dialog: 

 

 
 

As a result, the MassHunter Reporting Add-ins (which are VBA programs) are not allowed to run in 

MS Excel.  

 



 

Author:  Steve Madden Agilent Restricted Page 84 of 92    
LC/MS Product Support 
Version 2.0 – September 1, 2011  Printed Copies are Uncontrolled 

The solution is to follow the instructions in the MassHunter software installation guide on how to 

set the Trust Center settings in MS Excel. 

 

3.4.12 MS Excel 2003 gives error “Could not load file or assembly 

„Microsoft.Office.Interop.Excel‟” when printing reports 

 

This error typically means that an additional component called the Microsoft Office Interop 

Assemblies need to be loaded. 

 

 
 

The installation for the Interop Assemblies can be found in the root folder of the pre-B.02.00 

MassHunter installation CD-ROM (MassHunter rev. B.02.00 and above does not support Excel 

2003).  See the instructions in the installation guide for that version of MassHunter software.   

 

3.4.13 MassHunter Workstation PC is extremely slow and there are many 

EXCEL.EXE processes in the Window Task Manager 

 

With this problem the PC seems to run slower and slower.  Checking the Windows Task Manager 

shows that there are EXCEL.EXE processes, some of which may be consuming a significant 
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amount of CPU time.  The problem will continue until the PC is rebooted, but will eventually come 

back. 

 

There may be several possible causes to this problem. 

 

1) An additional Add-in from installing a software patch has been checked 

 

When opening the Add-ins dialog, the user will see an additional Add-in _MassHunter 

Reporting Quant checked: 

 

 
 

This Add-in was created when a patch was installed.  The problem and solution is fully 

described in the article ―Problem with Wrong Excel 2007 Add-in Being Checked‖ in LC/MS 

Support News # 196. 

 

2) An Add-in was created from a temporary copy after a software crash 

 

In this case, there is an additional Add-in created by a temporary copy of an Add-in that 

was left over after a software crash, usually of Qualitative Analysis, named ~$MassHunter 

Reporting Qual: 
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The problem and solution is fully described in the article ―Slow CPU Caused by Extra MS 

Excel Processes in Memory‖ in LC/MS Support News # 197. 

 

3) Qualitative Analysis has not shut down MS Excel processes properly 

 

As Qualitative Analysis is printing, it starts up one or more copies of the process 

EXCEL.EXE.  Versions of Qualitative Analysis prior to rev. B.03.01 did not always properly 

shutdown the EXCEL.EXE processes and sometimes would ―lose track‖ of them while 

running.  As a result, several unused EXCEL.EXE processes would reside in the PC‘s 

memory, taking up memory space.  This would continue until the PC was rebooted. 

 

The solution is to upgrade to a minimum of Qualitative Analysis rev. B.03.01 Build 346.0. 
 

3.4.14 Excel error “Runtime Error „5‟: The object file was not found”  

 

When this error is seen, it is usually when running an Autotune or Checktune.  The error will come 

up, the user presses OK, and then the tune report is printed.  The following procedure has fixed the 

problem at two customer sites: 

1) Shutdown MassHunter 

2) Open Excel 

3) Remove the add-in checkmarks in the check boxes,then click OK 
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4) Close Excel  

5) Restart Excel 

6) Activate the add-ins again (that is, select the Masshunter checkboxes) 

7) Restart MassHunter. 

 

3.4.15 Excel error “Runtime Error „5‟: Invalid Procedure Call or Argument” 

 

This error was seen at a customer site where the IT department had accidently installed Excel 2007 

using the Microsoft Office 2007 CD on top of Microsoft Excel 2007 without telling the FSE.  The 

specific form of the error was: 

 

Microsoft Visual Basic 

Runtime Error ‗5‘: 

Invalid Procedure Call or Argument 

<End><Debug<>Help> 

 

Reports were not being generated or printed at all.  The FSE investigated the error and found that 

the installation was part in C:\Program Files\Microsoft Office and part in C:\Program 

Files\Microsoft Office 2007.  He uninstalled and reinstalled Excel only in C:\Program 

Files\Microsoft Office, configured the add-ins and security settings, and everything started working 

correctly. 

 

3.4.16 Excel error “Old format or invalid type library” 

 

This error has been seen when attemping to print at sites where the customer has changed their 

Windows language setting from English (US) to another language which is not supported by 

MassHunter software (i.e. other than Japanese and Simplified Chinese).    The solution is to 

change the Windows language setting back to English (US). 

 

3.4.17 Excel error “Could not load file or assembly 'Microsoft.Office.Interop.Excel, 

Version=12.0.0.0‟” 

 

This error was observed at a customer site where the user had installed Microsoft Excel 2003 with 

MassHunter Qualitative Analysis rev. B.03.01 SP3, which is not supported.  The supported version 

of Microsoft Excel for that version is Excel 2007.  The full error message is: 
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Could not load file or assembly 'Microsoft.Office.Interop.Excel, Version=12.0.0.0, Culture=neutral, 

PublicKeyToken=71e9bce111e9429c' or one of its dependencies. The system cannot find the file 

specified. 

  

(Note; ―Version=12.0.0.0‖ is Microsoft‘s internal name for Office 2007.  Essentially, the 

MassHunter Reporting  add-in is looking for an Excel 2007 file and not finding it.) 

 

The solution was for the customer to obtain a copy of Microsoft Excel 2007 and install it. 

 

3.4.18 Tune reports do not print out, instead a template pops up at end of tune 

 

In addition to the problem in the title, the user also did not see the add-ins for Acq and Qual in the 

Excel OptionsAdd-ins dialog box.  

 

This cause was that the user had accidently loaded the 64-bit version of Excel 2010.  The only 

supported version of Excel or Office 2010 for MassHunter versions B.04.00 and B.05.00 is the 32-bit 

version.  Fortunately, the default installation from the Excel or Office DVD is the 32-bit 

installation—the user has to go out of the way to install the 64-bit installation. 

 

Microsoft, in fact, recommends that users continue to install the 32-bit version of Office if they are 

using 32-bit add-ins (like MassHunter Reporting).  Otherwise, the add-ins will not work: 

 

http://technet.microsoft.com/en-us/library/ee681792.aspx  

 

 

3.4.19 MassHunter Quant rev. B.04.00 never generates a report on Windows 7 

 

The symptom for this problem is that MassHunter Quantitative Analysis rev. B.04.00 never 

generates a report when run on Windows 7 Professional 64-bit.  Instead it will sit in a "Processing" 

status until the user cancels the report job.  The MassHunter Quant Reporting Add-in will not 

appear in the list of add-ins.  

 

The reason for the problem is that the Quant Reporting Service Pack 2 (SP2) was installed before 

Excel 2010.  If Excel 2010 (32-bit) is not installed before the Quant Reporting Service Pack 2 (SP2), 

when the Quant Reporting Service Pack 2 (SP2) is installed, it will install the 

MassHunter Quant Reporting Add-in in the wrong folder. It will install the MassHunter 

Quant Reporting Add-in in the 64-bit location: 

C:\Program Files\Microsoft Office\Office14\Library\ 

http://technet.microsoft.com/en-us/library/ee681792.aspx
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rather than the correct 32-bit location with the Acquistion and Qualitative Analysis Reporting Add-

ins: 

 

C:\Program Files(x86)\Microsoft Office\Office14\Library\ 

 

To fix a situation where the Quant Reporting Service Pack 2 (SP2) has been installed before Excel 

2010, copy the MassHunter Reporting Quant Add-in from the 64-bit location: 

 

C:\Program Files\Microsoft Office\Office14\Library\ 

 

to the 32-bit location: 

 

C:\Program Files(x86)\Microsoft Office\Office14\Library\ 

 

Then follow the directions on page 14 of the Agilent MassHunter Workstation Software – Offline 

Installation Guide (P/N G3336-90013) to bring up the Add-ins dialog. Enable the MassHunter 

Reporting Quant Add-in. 

 

For more details, see Service Note G3335AA MASSHUNTER SOFTWARE-99. 

 

3.4.20 Excel opens with a report, but not the right report 

 

The symptom for this problem is that the user will attempt to generate a report.  Excel will quickly 

pop up with a report, but not the correct report the user requested!  The reason is that earlier 

someone accidently saved a template with a report inside of it (e.g. in Process Report mode while 

editing the report).  As a result, during report generation it brings up the template with the old 

report in it. 

 

The solution is to repair the template by reinstalling it from another location.  Users who are 

editing templates should always inspect their templates before putting them into production use. 

 

3.4.21 Report is not generated or takes very long time to generate 

 

One cause of this problem is saving after changing the footer or header in the report template.  You 

must change to normal view before saving the template.  Otherwise, saving the template while in 

the header/footer view or page layout view corrupts the template.    

 

The solution is to repair the template by reinstalling it from another location. 
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3.4.22 Speeding up Quant report generation by upgrading Microsoft Office 2007 

 

A customer complained about the amount of time it took to generate their Quant reports.  After 

investigation, it was found that the report generation could be sped up by up to six times by 

installing the Microsoft Office 2007 SP2 upgrade: 

 

Original set up (Windows XP SP2 Excel 2007): 10 hours 32 minutes 

New set up (Windows XP SP3 Excel 2007 SP2): 1 hour 47 minutes 

 

The key is probably the upgrade of Excel 2007 to Excel 2007 SP2 (the Office Service Pack 2). 

The only supported operating system for Excel 2007 SP2 is Windows XP SP3 (not SP2), so both 

upgrades must be done. The speed-up is probably the result of fixes and optimizations to MS Excel 

2007 by Microsoft. It is unclear under what circumstances (e.g. what types of report templates) will 

benefit from the speed up. However, if you have a customer complaining of reporting speed issues, 

it is worth having them upgrade their Windows and Excel versions. 

 

In addition, the release of Quantitative Analysis rev. B.04.00 introduced a new set of stock 

templates called FAST.  These templates remove a small amount of flexibility in the templates (that 

most customers do not use) in exchange for much faster report generation. 
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3.5  Automation 
 

3.5.1 Shipping scripts do not show up in worklist‟s Script dropdown  

 

With this problem, the user attempts to select one of the shipping worklist scripts in the Script 

dropdown in the Select Script dialog (available from the Worklist Run Parameters dialog).  Instead 

of seeing a selecting of the shipping scripts: 

 

 
 

They have nothing in the Script dialog. 

 

The problem is usually caused by using non-US English settings for MS Windows.  The 

configuration files for the shipping scripts is kept in the folder 

D:\MassHunter\Scripts\Acq\Config\enu\MH_Acq_Scripts.  Because this folder specifies US 

English (enu) the MassHunter is unable to find it if another language setting is used. 
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3.5.2 UserDefined1 through 9 are not transferred from worklist to Quantitative 

Analysis 

 

Please see the description for this problem in the Quantitative Analysis section. 

 


